
In this lesson you will learn how you can set up a Multi to selectively ignore the grid to 
prioritise solar energy over the grid. This feature is called AC ignore.

The system will run in off-grid mode most of the time and will only let grid in when the 
batteries are empty or when the AC load is too big.
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Introduction

In this lesson you will learn how you can set up a Multi* to selectively ignore the 
grid. This feature can be used to prioritize solar energy over the grid. This feature 
is called AC ignore.

The AC ignore function can be set up so that the Multi will disconnect from the 
grid when the batteries are full enough and/or the AC load is not too big. The 
Multi will disconnect from the grid most of the time. It will only let the grid in 
when the batteries are empty or when you are running a big AC load. You now 
can use the grid like you would use a back-up generator. 
The mechanism behind the AC ignore function is the opening or closing the 
Multi’s internal AC input relay.

This feature in not enabled by default. To set it up you will need to change 
settings in the Multi. This is done by connecting a computer to the Multi and 
using VE.Configure 3 software.

* In this lesson Multi can mean any of our inverter/chargers like the Multiplus, MultiGrid, Quattro and EasySolar
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The AC input relay

How can a Multi ignore the grid? 

If you look at the internal wiring diagram of a Multi you will see that it has a relay on the AC 
input. This relay is called “AC input relay”. In some of our documentation the relay is called 
the “back-feed relay”.
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The normal function of this relay is to open as soon as the grid or generator is not there. For example, during a blackout or when a 
generator is off. This is a safety action. The relay prevents energy feeding into the grid during a blackout or when the generator is 
off.
This relay can also be setup to purposefully ignore the grid. It will still perform its normal safety action but it can open and
disconnect from the grid under more situations. It can ignore the grid when the batteries are still full enough. Now DC solar power 
can be prioritized and the grid will be used like a backup generator 



When can the grid be ignored ?

The AC input relay can be programmed to selectively ignore the grid, while looking at two parameters:
It can look at battery voltage and/or at AC load parameters. (Further in this lesson we will explain these parameters in more 
detail.)

The grid is ignored when the batteries are full enough. The grid is let in when the batteries are empty 
• This setting can be used to charge the batteries from the grid should the batteries get too empty. This can occur, for 

example, at night or during a long period of bad weather.
• In this scenario the Multi will look at the battery voltage. It will let the grid in when the battery voltage is too low, for a certain 

amount of time. It will ignore the grid as soon as the battery voltage has increased above a certain level, for a certain amount
of time.

• The multi can also disconnect the grid on battery state of charge.

The grid is ignored when the AC loads are low. The grid is let in when the AC loads are high
• This setting can be used to allow grid in when the AC load is higher than the Multi rating . This will prevent the Multi going 

into overload. This setting can also be used for large loads that you do not want to run from the battery.
• In this scenario the Multi will look at the AC load. As soon as it sees that the load is above a certain level, for a certain amount 

of time, the Multi will let the grid in. The multi will stop letting the grid in as soon as it sees that the AC load has dropped
below a certain level, for a certain amount of time.
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Installing and running VE.Configure 3 

In a Multi the “Ignore AC” feature is not enabled by default. This feature can only be enabled with a software program called 
VE.Configure 3. VE.Configure* is part of the VE Configuration tools package. This package is available free of charge from our 
website. 

Instructions:
• Download the VE Configuration tools package from  https://www.victronenergy.com/support-and-downloads/software
• Install the VE Configuration package on your Windows computer
• The package will install a number of software programs on your computer. One of these software files is the VE.Configure 

software program.

* In the rest of this lesson we will use the terminology VE.Configure instead of VE.Configure 3
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The next step is to connect your computer to the Multi. For this you will need hardware, like a cable and an 
interface. Please follow below instructions on how to do that. 
Please note, that it is also possible to run VE.Configure in demo mode. Demo mode can be used if you don’t 
have an actual Multi to connect to. For demo mode instructions see page 8.

Required items:
• A MK3-USB interface (The older MK2-USB can also still be used)

See: https://www.victronenergy.com/accessories/interface-mk3-usb

• A RJ45 UTP cable
See: https://www.victronenergy.com/cables/rj45-utp-cable

To connect a Multi to a computer:
• Disconnect the CCGX or Venus GX from the Multi (if present)
• Connect the MK3-USB interface to a USB port on your computer
• Connect the MK3-USB interface to a RJ45 UTP cable
• Connect the other side of the RJ45 UTP cable to one of the RJ45 connectors in the Multiplus. It does not 

matter which one of the connectors you use.
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RJ45 connectors

https://www.victronenergy.com/accessories/interface-mk3-usb
https://www.victronenergy.com/cables/rj45-utp-cable


Now you need to make VE.Configure connect to the Multi. This is how to do that:

Instructions
• Open VE.Configure on your computer
• Click on the [Port Selection] menu
• Select [Com port] 
• Then select [Auto detect]
• VE.Configure finds the Multi, connects to it and will retrieve the settings
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You can also run VE.Configure in “demo mode”. Demo mode allows you to practice configuration without the need to connect 
to an actual Multi. This is especially handy if you want to follow this lesson and you don’t have an actual Multi nearby. Use the 
demo mode to configure a “virtual” unit.

To enter “demo mode”:
• Click on the [Port Selection] menu
• Select  [Fake target with full options].
• Select the unit of your choice

It is also possible to view and/or make changes to a previously saved VE.Configure file. 

In that case: 
• Click on the [Port Selection] menu
• Select [Fake target from file]

TIP:
To change the VE Configure language:
• Click on the [Options] menu
• Select [Language] 
• Select [check online for language]
• Choose your preferred language.
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It is good practice to always save the Multis existing settings 
before making any changes to the settings. 
This useful in case you need the initial configuration.  

Instructions:
• Click on the [Get settings] button
• Wait for the settings to be retrieved
• Then click on the [File] menu
• Select [Save settings]
• A file containing the settings will be saved

It is also possible to load settings from an earlier saved file.

Instructions:
• Click on the [File] menu
• Select [Load settings]
• You will be asked which file you want to load
• Click on the [Send settings] button
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Programming AC ignore settings

To program the AC ignore settings you will have to go to 
the “Virtual switch” tab in VE. Configure. 

Virtual switch (VS) is the part of VE.Configure where you 
can make advanced settings. Like driving the 
programmable relay or set up Ignore AC.
First you need to select what function you want Virtual 
switch to perform. In this case you want to choose “Ignore 
AC.” 

Instructions:
• Go to the [Virtual switch] tab 
• Go to the [Usage] tab
• Select the [dedicated ignore AC input] option
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In the “Ignore AC” tab you can specify the battery voltage 
and/or AC load parameters on which the Multi should 
decide to ignore or not to ignore the grid.

Instructions:
• Go to the [Ignore AC input] tab

Hint:
When a time of -1 second is chosen, the condition is  
deactivated. The text is grey. 
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Accepting grid on AC load conditions

This setting can be used to allow grid in when the AC load is higher 
than the Multi rating. This will prevent the Multi going into 
overload. This setting can also be used for large loads that you do 
not want to run from the battery.

In this example the grid will not be ignored when the load exceeds 
4000 Watt for more than 30 seconds.
Do not ignore AC input means that the grid is accepted because the 
AC input relay is closed 

The grid will be ignored when the load drops below 2999 W for 
more then 2 minutes.
Ignore AC means that the grid is ignored because the AC input relay 
is open.

It is important to leave a significant time interval between 
connecting to and disconnecting from the grid. This is so the AC 
input relay does not open and close to frequently.

Victron Energy Learning - Virtual Switch ignore AC - Lesson 12



Accepting grid on battery voltage conditions

This setting can be used to charge the batteries from the grid should 
the batteries get too empty. This can occur, for example, at night or 
during a long period of bad weather.

In this example, the grid is not ignored when the battery voltage is 
less than 47 Volt for 60 seconds.
Do not ignore AC input means that the grid is accepted because the 
AC input relay is closed.
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The grid will be ignored again when the battery voltage exceeds 51 Volt for more than 3 minutes. 
Ignore AC means that the grid is ignored because the AC input relay is open.

Apart from “battery voltage”, there are two other options to choose from: “bulk finished” or “absorption” finished”.
Choosing “absorption finished” is a good way to ensure the batteries are getting a full charge every now and then. But it can
lead to a higher electricity bill. The absorption charge stage of a lead-acid battery is much less efficient than the bulk stage. 
This could be a reason to choose the “bulk finished” option. At the end of the bulk charge stage a lead-acid battery is about 
85% full. 
For more information about bulk and absorption please see the Victron Energy book “Energy Unlimited”, page 25. Follow this 
link:  https://www.victronenergy.com.au/orderbook

https://www.victronenergy.com.au/orderbook


Accepting grid on state of charge

It is also possible to let grid in when the batteries fall below a certain state of 
charge. 

IMPORTANT
In a DC coupled solar system the “state of charge” option should only be used if 
you have a Color Control GX or Venus GX in the system. And the Color Control GX 
or Venus GX is connected to both the Multi and the MPPT solar charger(s) and/or a 
BMV battery monitor. In addition to this a setting needs to be made in the Color 
Control GX or Venus GX . See this link for more information: 
https://www.victronenergy.com/live/ccgx:start#battery_state_of_charge_soc

Instructions:

• Go to the [General] tab in VE.Configure
• Tick the [Enable battery monitor] tick box
• Fill in the battery capacity
• Fill in the charge efficiency. This should be around 0.8 for lead-acid batteries

• Then go to the [Virtual switch] tab
• Go to the [Ignore AC input] tab
• Fill in state of charge lower than 50% (for lead acid batteries)
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100% self-consumption by disabling the charge functionality of the Multi

It can be quite expensive to charge the batteries from the grid. Lead-acid batteries have a low charge efficiency. About 20% of 
the energy used to charge the batteries is lost in the form of heat. Some installers therefore prefer to disable the charger 
functionality of the Multi. 
When the charger functionality is disabled and the Multi is accepting the grid, it will supply the loads with grid power, but will 
not charge the batteries. The batteries will only receive charge from the MPPT charge controllers. In this type of system it is 
very important to have a large enough solar array. It also important that the Ignore AC battery voltage settings are set higher 
than you would do normally. This is to make sure that the battery has some extra charge left should there be blackout. 

Instructions:

• Go To the [charger] tab
• Untick the [Enable charger] tick box

• Go to the [Virtual switch] tab
• Go to the [Ignore AC input] tab
• Increase the [when Udc lower than] value

Victron Energy Learning - Virtual Switch ignore AC - Lesson 15

WARNING
Incorrect system design can cause battery damage
Disabling the charger is only recommended in systems that 
have excess solar power. 
If the batteries get empty during the night, the system 
cannot be recovered unless you connect an external battery 
charger.



Low battery voltage inverter shutdown

The “DC input low shut-down voltage” parameter is the battery bank voltage at which below the inverter will stop operating. 
This feature protects the battery bank from becoming to deeply discharged. If this value is set too low, the batteries will get 
discharged too deeply and they will get damaged. This will reduce the lifetime of the batteries.

By default the Multi is set at a very low “DC input low shut-down” voltage. You should this value in VE.Configure. This so the 
batteries are better protected. We advice to set this voltage to 44V (for a 48V battery bank*). When you change the “DC input 
low shut-down” voltage,  the “DC input low restart” voltage will automatically increase. Therefore you will need to reduce this 
voltage again.  Set the “DC input low restart” voltage to 4V above the shut down voltage.

Instructions:
• Go to the [Inverter] tab
• Set [DC input low shut-down] to 44V
• Set [DC input low restart] to 48V
• Set [DC input low pre-alarm] to 45V

* For a 24V system divide these voltages by 2 and for a 12V system divide these by 4.
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Finished programming

When you have completed the VE configure settings, you will 
need to send those settings to the Multi. You can do this by 
clicking the “send settings” button.

It is good practice, to also save a copy of the setting to your 
computer. This way you will always have a record of the settings 
you have made for your customer.

To save the settings on your computer:
• Go to the [File] menu
• Click on [Save Settings]
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VE Configure 3 tutorial

Should you want to learn more about VE. Configure, we have an instruction video available from our website. The video is in 
English, but subtitles are available for many other languages.

This is the link: https://youtu.be/V1Zceq02vMA
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Assistants - Advanced AC ignore functionality

It is also possible to use “Assistants” to program advanced AC ignore situations. For example AC ignore by looking at state of 
charge values from a BMV battery monitor. However, in this lesson we purposefully decided to just explain the AC ignore 
settings via Virtual switch to be used in simple systems.
“Assistants” are more complex to set up or to program. For example “Assistants” are only possible after a firmware update of 
the Multi. For those of you that want to find out more about ‘Assistants” please contact you Victron Distributor. 
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Warning and disclaimer

The only aim of this lesson is to help you to understand the basic principles of a Victron Energy system that selectively connects 
to the grid. We will not be held responsible in case of damages caused by inappropriate installation of our products.

• Please be aware that incorrect grid ignore settings can discharge batteries too far and can cause irreparably battery damage.
• Read and understand the safety warnings published in the product manuals.
• Professional advice and instruction should always be sought before commencing any electrical work.
• Electrical installations and installation work must always be compliant with the local standards and authority requirements.



Summary

In this lesson you have learned how you can set up a Multi to selectively ignore the grid, so solar energy will be prioritised over 
the grid. This feature is called “AC ignore”.

The following was explained:

• The mechanics behind the AC ignore feature
• The criteria when to ignore the grid
• How to download, setup and connect VE.Configure
• How to program the AC ignore settings into the Multi by using VE.Configure
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Energy. Anytime. Anywhere.
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